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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or 
omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. 
Government under vendor's standard commercial license.

Copyright Notices

© Copyright 2006-2007 Hewlett-Packard Development Company, L.P.

This product includes i-net OPTA software, which is © Copyright 2002-2006 i-net software 
GmbH, Berlin, Germany.

Trademark Notices

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

AMD is a trademark of Advanced Micro Devices, Inc.

HP-UX Release 11.00 and later (in both 32 and 64-bit configurations) on all HP 9000 
computers are Open Group UNIX 95 branded products.

Intel and Pentium are registered trademarks of Intel Corporation or its subsidiaries in the 
United States and other countries.

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of 
Sun Microsystems, Inc. in the U.S. and other countries.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.
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Support

You can visit the HP software support web site at:

http://www.hp.com/managementsoftware/support 

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit enhancement requests online

• Download software patches

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Enter discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many 
also require a support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to: 

http://www.managementsoftware.hp.com/passport-registration.html 
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Documentation Roadmap

Figure 1 on page 8 shows the documentation roadmap for HP Operations 
Dashboard Operations View. This roadmap presents a suggested order for 
reading the manuals available with Operations View:

1 Use the Installation Guide to install the product.

2 Follow the path for Operations View.

a Use the Operations View Quick Start Guide to carry out the tutorial.

b Read the “Essential Concepts” chapter of the Operations View 
Administrator Guide to understand the concepts of working with 
portlets and portal servers.

c Use the Operations View Administrator Guide to configure and 
maintain the product. This guide provides high-level instructions for 
the common tasks when working with the supplied Operations View 
portlets 

d If you are migrating from HP OpenView Service Information Portal to 
Operations View, use the Operations View Migration Guide to 
complete this task. The Operations View Administrator Guide refers 
you to the Operations View Migration Guide at the appropriate point 
in the portal view implementation process.

e Reference the integration guides as needed for specific details on each 
supported HP OpenView management product. The Operations View 
Administrator Guide refers you to the integration guides at the 
appropriate points in the portal view implementation process.
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Figure 1 Operations View Documentation Roadmap
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HP Operations Dashboard Manuals

Table 1 describes the HP Operations Dashboard manual set. These documents 
are provided in Adobe Acrobat (.pdf) format and can be found in the following 
directories:

• After HP Operations Dashboard installation, in the following directory on 
the HP Operations Dashboard management station:

— Windows: <install_dir>\paperdocs\dashboard\

— UNIX: /opt/OV/paperdocs/dashboard/

• On the product DVD-ROM in the following directory:

— Windows: \Docs\

— UNIX: /Docs/

For information on how to obtain the most recent documents, see 
Documentation Updates on page 13.

Table 1 HP Operations Dashboard Documentation

Document Title and Filename Main Topics

Installation Guide
Installation.pdf

Installing and uninstalling HP Operations 
Dashboard

Migration Guide
Migration.pdf

• Overview of migrating from 
HP OpenView Service Information Portal 
(SIP) version 3.2 to Operations View

• SIP and Operations View comparison
• Migration use models
• Using the Operations View Migration 

Wizard
• Manual steps for migration
• Jetspeed user migration for RealTime 

Health View and Operations View
• Troubleshooting
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Operations View Quick Start Guide
opview/Quick_Start.pdf

• Running the Operations View 
demonstration portal view

• Operations View tutorial

Operations View Administrator Guide
opview/Administration.pdf

• Essential concepts
• Planning roadmap for using Operations 

View
• Connecting Operations View to 

management products
• Configuring Operations View portlets
• Configuring Operations View data filters
• Deploying a portlet application
• Troubleshooting

Operations View Integration Guide: NNM
opview/NNM_Integration.pdf

• Connecting Operations View to 
HP OpenView Network Node Manager 
(NNM)

• Configuring the NNM portlets
• Customizing the NNM portlets
• Filtering NNM data
• Troubleshooting

Operations View Integration Guide: OVO and 
OVSN
opview/OVO_OVSN_Integration.pdf

• Connecting Operations View to 
HP OpenView Operations (OVO) and 
HP OpenView Service Navigator (OVSN)

• Configuring the OVO and OVSN portlets
• Customizing the OVO and OVSN portlets
• Filtering OVO and OVSN data
• Troubleshooting

Operations View Integration Guide: OVIS
opview/OVIS_Integration.pdf

• Connecting Operations View to 
HP OpenView Internet Services (OVIS)

• Configuring the OVIS portlets
• Customizing the OVIS portlets
• Troubleshooting

Table 1 HP Operations Dashboard Documentation (cont’d)

Document Title and Filename Main Topics
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Operations View Integration Guide: OVPM
opview/OVPM_Integration.pdf

• Connecting Operations View to 
HP OpenView Performance Manager 
(OVPM)

• Configuring the OVPM portlets
• Customizing the OVPM portlets
• Filtering OVPM data
• Troubleshooting

Operations View Integration Guide: OVSD, 
OVPI, and OVR
opview/OVSD_OVPI_OVR_Integration.pdf

• Connecting Operations View to 
HP OpenView Service Desk (OVSD), 
HP OpenView Performance Insight 
(OVPI), and HP OpenView Reporter 
(OVR)

• Configuring the OVSD, OVPI, and OVR 
portlets

• Customizing the OVSD, OVPI, and OVR 
portlets

• Troubleshooting

Table 1 HP Operations Dashboard Documentation (cont’d)

Document Title and Filename Main Topics
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Operations View Online Help

Operations View supplies the following graphical interfaces for portal and 
portlet configuration:

• Operations View Administrator Tool

• Operations View Migration Wizard (available from the Administrator 
Tool)

Each of the Operations View graphical interfaces includes online help files 
that explain that interface.

• To access the top level of the help content for each interface, use the 
commands on the Help menu.

• To access context-specific help information in the Operations View 
interfaces, click Help within the window for which you want more 
information.
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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of 
the software

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the 
appropriate product support service. Contact your HP sales representative for 
details.
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Documentation Conventions

The Operations View documentation uses the following conventions:

Table 2 HP Operations Dashboard Documentation Conventions

Symbol Meaning

<install_dir> (Windows only.) The HP OpenView application directory. This 
directory contains all of the HP Operations Dashboard files. 
The default location is:
C:\Program Files\HP OpenView\

<data_dir> (Windows only.) The HP OpenView data directory. This 
directory contains product configuration and data files. The 
default location is:
C:\Program Files\HP OpenView\data

<portlet_app_dir> The top-level directory for a deployed portlet application. This 
directory has the same name as the portlet application. The 
location of this directory depends on the installation platform 
and the portal server.
• Jetspeed on Windows:

<install_dir>\nonOV\dashboard\jetspeed\2.1\webapps

• Jetspeed on UNIX:
/opt/OV/nonOV/dashboard/jetspeed/2.1/webapps

• BEA WebLogic on Windows (default):
<bea_install_dir>\user_projects\applications

• BEA WebLogic on UNIX (default):
<bea_install_dir>/user_projects/applications

<bea_install_dir> is the BEA WebLogic directory.

A note that describes special information pertaining to the 
current topic.

A tip that provides an alternate way to address the current 
topic.

A caution that indicates a potential problem to avoid.
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1 Introduction to the OVIS Integration

The HP OpenView Internet Services (OVIS) product helps you to proactively 
monitor standard internet services by collecting information about these 
services. OVIS models each internet service as a service type. The following 
list is a subset of the service types monitored by OVIS:

The current list of services that OVIS monitors is available at: http://
www.managementsoftware.hp.com/products/OVIS/index.html.

• COMAPP: OVTA COM Application
• DHCP: Dynamic Host Addresses
• DIAL: Dial-up Networking Service
• DNS: Domain Name Server
• EXCHANGE: Exchange Mail 

Service
• FTP: File Server
• HTTP: Web Pages
• HTTP_TRANS: Web Transactions
• HTTPS: Secure Web Pages
• ICMP: TCP/IP Availability (ping)
• IMAP4: Email Service
• JavaAPP: OVTA Java Application
• LDAP: Directory Service
• MAILROUNDTRIP: Round Trip 

Email
• MSGAPP: OVTA Msg Application
• NNTP: News Service
• NTP: Network Time Service

• ODBC: Database Service
• POP3: Mail Server
• RADIUS: Authentication Service
• SAP: SAP Basics
• SCRIPT: Generic Script Service
• SMS: Short Message Service
• SMTP: Mail Service
• SOAP: SOAP 1.1
• SOAPAPP: OVTA SOAP 

Application
• STREAMING_MEDIA: Streaming 

Media
• SYS_BASIC_WMI: Basic System 

Metrics (WMI)
• TCP: TCP Port Service
• TFTP: Trivial FTP Server
• UDP: Performance
• WAP: Wireless Service
• WEBAPP: OVTA Web Application

http://www.managementsoftware.hp.com/products/OVIS/index.html
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You can display the OVIS information through the HP OpenView Dashboard 
Operations View Internet Services and Internet Services Dashboard portlets. 
These portlets offer a secure and highly customizable view of the processes 
that OVIS is currently monitoring.

For more information about configuring OVIS, see the documentation set that 
came with OVIS, such as the Active Monitoring Concepts Guide. All 
HP OpenView manuals are available online. See Documentation Updates on 
page 13.

You can view the data that OVIS collects through the Operations View 
Internet Services portlets:

• Internet Services portlet

See The Internet Services Portlet for Operations View on page 17.

• Internet Services Dashboard portlet

See The Internet Services Dashboard Portlet for Operations View on 
page 18.

Operations View protects OVIS information by mapping a portlet to 
OVIS-defined customers.
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The Internet Services Portlet for Operations View

The Internet Services portlet offers a secure and highly customizable view of 
the internet services that OVIS monitors. The portlet displays the OVIS data 
as a set of gauges, charts, and graphs.

You can perform the following tasks in the Internet Services portlet:

• View a “snapshot” for any OVIS customer and for any OVIS-defined 
service (for example, HTTP, DNS, FTP).

• View detailed availability information and response time charts and 
graphs by clicking on the gauge icons.

• View detail on service-level violation reports.

• Customize which gauges, graphs, and charts are displayed.

• Select the time interval of gauges, charts, and graphs.

• Connect remotely to OVIS measurement servers.

• Use multiple instances of the Internet Services portlet simultaneously.

• Enable single-sign-on: The user logs into the portal, and the system 
displays only the user’s configured information from OVIS.

• Define mapping of a portal user to an OVIS customer.
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The Internet Services Dashboard Portlet for Operations 
View

The OVIS Dashboard portlet presents a summarized view of the health of 
various services configured in OVIS. It lets you filter the data based on one or 
more customers.

You can perform the following tasks in the Internet Services Dashboard 
portlet:

• View a summarized snapshot of the health of various services. The 
services are also grouped into customers and also consolidated into All 
Resources.

• Drill down from services to targets and locations for targets

• View a graphical snapshot of the services with graphs for SLO Violations, 
Availability, Response time, alarms and all other service-specific metrics.

• View alarms associated with a service or a target and also consolidated for 
each customer or All Resources

• View baseline graphs for any target, service, or customer, and choose the 
baseline for any metric on any week day.

• Filter the presented data based on the customers that are associated with 
the portlet.
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Interaction Between OVIS and Operations View

Operations View running on any supported operating system can integrate 
with multiple OVIS measurement servers, regardless of the OVIS operating 
system. The Installation Guide includes information about supported OVPI 
versions and required patches.

You can install Operations View and OVIS in any order; however, you must 
perform at least minimum OVIS configuration before you can configure the 
Internet Services portlets. For information on configuring OVIS, see the 
documentation that came with that product.

Before using the Internet Services portlets, configure Operations View and 
OVIS to communicate with each other. See Chapter 2, Configuring the 
Operations View Connection to OVIS.

Figure 2 on page 20 illustrates how the Internet Services portlet 
communicates with OVIS.

Figure 3 on page 21 illustrates how the Internet Services Dashboard portlet 
communicates with OVIS.
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Figure 2 Communication Process for the Internet Services Portlet
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Figure 3 Communication Process for the Internet Services 
Dashboard Portlet
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2 Configuring the Operations View 
Connection to OVIS

To establish communication between your HP OpenView Internet Services 
(OVIS) measurement servers and HP OpenView Dashboard Operations View, 
perform the following configurations on each OVIS measurement server and 
on the Operations View server.

On the OVIS Measurement Server

The Internet Services and Internet Services Dashboard portlet preferences 
map the portlet to OVIS customer settings. The Internet Services portlet only 
displays data for the specified OVIS customer.

Perform the following steps on each OVIS measurement server in your 
network:

1 Verify that you are using a version of OVIS that is supported by 
Operations View. Refer to the Installation Guide for the list of supported 
product versions.

2 Verify that the OVIS measurement server has at least one configured 
customer. Make note of the currently defined OVIS customer settings and 
their respective passwords, if applicable. You need this information for 
configuring the portlet.
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3 If you plan to use the Internet Services Dashboard portlet, for OVIS 
version 6.0 or later, determine the information for connecting to the OVIS 
database:

• Database type: The default is Microsoft Database Engine (MSDE). 
OVIS also supports Oracle and SQL Server.

If the OVIS database is MSDE or SQL Server, ensure that the 
database is running in mixed mode. See Configuring MSDE to Run in 
Mixed Mode on page 24 or Configuring SQL Server to Run in Mixed 
Mode on page 25.

• Database port: The port on which the database instance is running. To 
find the port number for MSDE or SQL Server, see Determining the 
MSDE Port Number on page 25 or Determining the SQL Server Port 
Number on page 26.

If the MSDE and SQL Server port numbers are set dynamically, the 
port number might change each time the database is restarted. In this 
case, you will need to update the connection information each time the 
port number changes. To avoid the need for configuration changes, you 
can configure the database to use static ports. See Configuring an 
Instance of MSDE to Use a Static Port on page 26 or Configuring an 
Instance of SQL Server to Use a Static Port on page 27.

• Database hostname: In most cases. this is the OVIS management 
station. If this value is not specified, Operations View uses the OVIS 
management station as the OVIS dashboard database host.

• Database user and password: The user name and password for 
connecting to the OVIS dashboard database.

Configuring MSDE to Run in Mixed Mode

To configure the MSDE database to run in mixed mode, follow these steps:

1 From the Control Panel, open the Services window.

2 In the Services window, stop the MSSQLSERVER process and all other 
related services (such as SQLSERVERAgent).

3 On the Start menu, click Run, type regedt32, and then click OK to open 
the Registry Editor.
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4 In the Registry Editor, locate and select the following key: 
HKEY_LOCAL_MACHINE\Software\Microsoft\Microsoft SQL 
Server\OVOPS\MSSQLServer\

5 In the right pane, double-click LoginMode.

6 In the DWORD Editor window, set the LoginMode subkey to 2, verify that 
the Hex option is selected, and then click OK.

7 In the Services window, restart the MSSQLSERVER and the 
SQLSERVERAgent services.

Configuring SQL Server to Run in Mixed Mode

To configure the SQL Server database to run in mixed mode, follow these 
steps:

1 On the Start menu, click All Programs→ Microsoft SQL Server→ Enterprise 
Manager to open the SQL Server Enterprise manager.

2 Drill down to the database instance used by OVIS. Typically, this database 
instance is named <machine>\OVOPS.

3 Right-click the OVIS database, and then click Properties.

4 In in the SQL Server Properties window, click the Security tab.

5 In the Authentication area of the Security tab, select SQL Server and 
Windows as the authentication mechanism, and then click OK.

6 Restart SQL Server.

Determining the MSDE Port Number

To determine the port number currently being used the by MSDE database, 
follow these steps:

1 Using any text editor, open the SQL Server log file: 
<install_dir>\MSSQL$OVOPS\LOG\ERRORLOG

2 Look for lines that are similar to the following example:

2005-11-30 11:06:33.29 server SQL server listening on 192.168.0.5: 3887.
2005-11-30 11:06:33.29 server SQL server listening on 127.0.0.1: 3887.
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3 The port number listed at the end of the message (3887 in this example) is 
the port number to use for connecting to the database.

Determining the SQL Server Port Number

To determine the port number currently being used the by SQL Server 
database, follow these steps:

1 On the Start menu, click All Programs→ Microsoft SQL Server→ Enterprise 
Manager to open the SQL Server Enterprise manager.

2 Drill down to the database instance used by OVIS. Typically, this database 
instance is named <machine>\OVOPS.

3 Drill down to Management and SQL Server Logs.

4 Open the Current log file.

5 Look for lines that are similar to the following example:

2005-11-30 11:06:33.29 server SQL server listening on 192.168.0.5: 3887.
2005-11-30 11:06:33.29 server SQL server listening on 127.0.0.1: 3887.

6 The port number listed at the end of the message (3887 in this example) is 
the port number to use for connecting to the database.

Configuring an Instance of MSDE to Use a Static Port

To configure an instance of the MSDE database to use a static port, follow 
these steps:

1 On the Start menu, click Run, type regedt32, and then click OK to open 
the Registry Editor.

2 In the Registry Editor, locate and select the following key: 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL 
Server\OVOPS\MSSQLServer\SuperSocketNetLib\Tcp

3 In the right pane double-click TcpPort.

4 If TCPPort is set to 0, change this value to a static port number, and then 
click OK.

5 Restart MSDE.
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6 Using any text editor, open the SQL Server log file 
<install_dir>\MSSQL$OVOPS\LOG\ERRORLOG, and verify that the 
configured port is being used.

Configuring an Instance of SQL Server to Use a Static Port

To configure an instance of the SQL Server database to use a static port, 
follow these steps:

1 Start the Server Network Utility in one of the following ways:

• On the Start menu, click All Programs→ Microsoft SQL Server→ Server 
Network Utility.

• On the Start menu, click Run, type svrnetcn.exe, and then click OK.

2 In the SQL Server Network Utility window, click the General tab.

3 In the list of instance(s) on this server, select the instance of SQL Server 
running the OVIS database. Typically, this database instance is named 
<machine>\OVOPS.

4 In the Enabled Protocols box, click TCP/IP, and then click Properties.

5 In the Default port box, type a static port number, and then click OK.

6 Click OK, and then click OK again.

7 Restart the instance of SQL Server.

8 Using any text editor, open the SQL Server log file 
<install_dir>\MSSQL$OVOPS\LOG\ERRORLOG, and verify that the 
configured port is being used.
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On the Operations View Server

To enable communication between Operations View and OVIS, follow these 
steps:

1 In the scoping pane of the Operations View Administrator Tool, navigate 
to the Management Stations folder.

2 To add a new OVIS management station, right-click Management 
Stations, click New Management Station, and then type the fully-qualified 
host name of the OVIS management station.

To add OVIS settings to an existing management station, select that 
management station in the scoping pane.

3 In the editor pane, select OVIS is Installed on this System.

The OVIS tab becomes available.

4 On the OVIS tab, set the configuration options as appropriate for the 
version of OVIS running on the management station that you identified in 
Step 2:

• Access method: Select whether to use HTTP or HTTPS for 
communicating with OVIS.

• Web server port: Specify the port that the OVIS web server uses.

— For HTTP, the default port is 80.

— For HTTPS, the default port is 443.

• OVIS 6.0 or later: Select this check box if the OVIS on this 
management station is version 6.0 or later.

Selecting this check box makes the settings for the Internet 
Services Dashboard portlet available. The Internet Services 
Dashboard portlet requires OVIS version 6.0 or later.
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5 For the Internet Services Dashboard portlet, set the remaining 
configuration options:

• In the Dashboard General Settings area of the OVIS tab, specify the 
following information for connecting to the OVIS dashboard:

— Dashboard port: The Tomcat application server port on the OVIS 
management station. The default port is 8080.

— Dashboard user and password: The user name and password for 
connecting to the OVIS dashboard.

If restricted views are enabled for the OVIS dashboard, set the 
dashboard user to All Customers to display all available data, or 
specify one dashboard customer name to limit the data that is 
available to the Internet Services Dashboard portlet.

If restricted views are not enabled for the OVIS dashboard, leave 
the user and password fields empty.

• In the Dashboard Database Settings area of the OVIS tab, specify the 
following information for connecting to the OVIS dashboard database. 
For information, see On the OVIS Measurement Server on page 23.

— Database hostname

— Database type

— Database port

— Database user and password

• In the Health area of the OVIS tab, specify the service level violation 
health percentages. The default ranges are as follows:

— Green: 0 through 10

— Yellow: above 10 through 20

— Red: above 20 through 100

6 Click Save.

7 Repeat Step 2 though Step 6 for each OVIS management station with 
which Operations View should communicate.
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Running in Languages Other Than English

Any language that can be displayed within the UTF-8 codeset can be 
displayed through Operations View.

Configuring Operations View to Access UTF-8 Data From OVIS

OVIS does not use the UTF-8 character set that is required by Operations 
View. Operations View can display data from OVIS running in languages 
other than English, if you take the following precautions:

1 On the Operations View server, when entering the OVIS customer names 
and passwords into Operations View management station configuration 
settings, use only ASCII characters. (See On the Operations View Server 
on page 28.)

2 On the OVIS measurement server:

• Ensure that the OVIS customer names that Operations View accesses 
are configured with ASCII characters.

• If running OVIS in restricted mode, ensure that the OVIS customer 
passwords are configured with ASCII characters.
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HTTPS Support

The Internet Services portlet can be configured to use the secure hypertext 
transfer protocol (HTTPS) for communicating with the web server process on 
the OVIS measurement server.

The Internet Services Dashboard portlets can be configured to use the secure 
hypertext transfer protocol (HTTPS) for communicating with the Tomcat 
application server process on the OVIS measurement server. This portlet uses 
a regular JDBC connection to the OVIS database; it does not support secure 
JDBC access.

After configuring HTTPS, update the Operations View management station 
configuration for the OVIS measurement server. See Step 4 on page 28.
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3 Working with the Internet Services 
Portlet

HP OpenView Dashboard Operations View provides the Internet Services 
portlet for integrating with HP OpenView Internet Services (OVIS).

This chapter describes how to create, configure, use, and customize the 
Internet Services portlet. For an overview of the portlet’s functionality, see 
Chapter 1, Introduction to the OVIS Integration.

The portal view development process includes a variety of tools:

1 Use the Operations View Administrator Tool to create the Operations 
View portlets within a portlet application. See Creating the Internet 
Services Portlet on page 34.

2 Use the Administrator Tool to perform initial configuration of the 
Operations View portlets. See Configuring the Internet Services Portlet on 
page 35.

3 Deploy the portlet application to the portal server. For information, refer 
to the Operations View Administrator Guide.

4 Use the portal server software tools to create a portal view that includes 
the Operations View portlets. For information, refer to the portal server 
software documentation.

5 In a web browser, view the portal view and customize the contained 
portlets. See Using the Internet Services Portlet on page 38.

This is the only point at which end users can interact with the Operations 
View portlets. If you allow portlet customization, refer to the Operations 
View Administrator Guide for information about the scope and effects of 
portlet customization.

6 Use the Administrator Tool to maintain the Operations View portlet 
configurations. See Customizing the Internet Services Portlet on page 42.
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Creating the Internet Services Portlet

Use the Administrator Tool to create the Internet Services portlet within an 
existing portlet application.

To create the Internet Services portlet, follow these steps:

1 In the Administrator Tool, click File→ New→ Portlet.

2 In the Add New Portlet window, enter the following information:

• Portlet Name: The name of the portlet as it appears in the portlet 
application in the scoping pane and in the portal server software tools.

• The portlet name must be unique, start with a letter or underscore 
character, and consist of only alphanumeric and underscore 
characters.

• Portlet Title: The name of the portlet as it appears in the portal server 
software tools and the portal view. Defaults to the portlet name.

• Description (optional): The portlet description as it appears in the 
portal server software tools.

• Portlet Type: Select OVIS from the list.

• Destination Portlet Application: Select the portlet application to 
contain the new portlet.

The new portlet appears in the selected portlet application in the scoping 
pane, and the configuration information for this portlet appears in the 
editor pane.
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Configuring the Internet Services Portlet

For information on the Internet Services portlet configuration options, click 
Help at the bottom of the editor pane to view the online help page.

To configure the default settings for the Internet Services portlet, follow these 
steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet 
Applications folder, expand the desired portlet application, and then click 
the name of the Internet Services portlet (named OVIS by default).

The editor pane displays the configuration for this portlet as shown here.



36 Chapter 3

HP Operations Dashboard Operations View Integration Guide: OVIS Version 2.10



Working with the Internet Services Portlet 37

Version 2.10 HP Operations Dashboard Operations View Integration Guide: OVIS

2 In the General Settings area, make any desired changes.

3 On the General Parameters tab of the OVIS Portlet Edit area, set the 
configuration options. At a minimum, specify the correct values for the 
following options:

• Server

• Customer Name

• Customer Password (and Confirm Customer Password)

4 On the Services tab of the OVIS Portlet Edit area, set and configure the 
services to monitor.

• To add a service, select that service in the Available Service Types list, 
and then click Add.

• To remove a service, select that service in the table, and then click 
Remove.

• To configure a service, in the table row for that service, select the 
check boxes for the information to collect.

• To set the display order for the service information, click Move Up and 
Move Down to arrange the order of the table rows.

5 Click Save.
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Using the Internet Services Portlet

The Internet Services portlet shows, at a glance, the most important 
information about a service. Figure 4 shows an example of the Internet 
Services portlet.

Figure 4 Deployed Internet Services Portlet
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The Change Time Interval list in the title bar of the Internet Services portlet 
(as shown in allows the user to set the time interval for the current session’s 
display. After logging off and logging back into the portal, the Internet 
Services portlet reverts to the default time interval.

Figure 5 Change Time Interval

For information about changing the default time interval, see Customizing the 
Internet Services Portlet on page 42.

For each service type, the following information from OVIS can be displayed in 
the Internet Services portlet:

• Availability gauge: Is the service available?

• Response Time gauge: How quickly is the service responding to requests?

• Service Level (SLO) Compliance gauge: Have the OVIS service objectives 
been met?

• Response Time Components graph: What is the response time of the 
service and its subcomponents over the last specified time period?

• Availability history graph: Has the service been available over the past 
couple hours or weeks?

• Service Level Violations graph: Which services have not met the defined 
objectives?

Internet Services Gauges

Each gauge represents a summary of subcomponent information. Click a 
gauge to view information organized into the following categories:

• Service Groups: Displays a breakdown of the target groupings that are 
included in a service type. For example, in OVIS, you can split your HTTP 
web servers into three or more groups. The response time, availability, and 
service-level violations are reported for each group of web servers.
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• Customers: Displays performance, availability, response time, and 
service-level violations by customer.

• Work Shifts: Displays availability, response time, and service-level 
violations over different periods of time.

Figure 6 Gauges
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Internet Services Graphs

The Response Time, Availability, and Service-Level Violation graphs provide 
information relevant to the service type.

Figure 7 Graphs
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Customizing the Internet Services Portlet

If you grant portlet edit privileges, a user of the Internet Services portlet can 
change the following configurations for their portlet instance:

• OVIS management station

• Data time interval

• Displayed service types

• Displayed gauges and graphs for each service type

Figure 8 shows an example of the Internet Services portlet edit page.

Figure 8 Internet Services Portlet Edit Page
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Changing the OVIS Management Station

By default, Operations View contacts the OVIS measurement server specified 
in the current portlet properties (see On the Operations View Server on 
page 28). Operations View gathers OVIS data from the selected server.

To override the default OVIS server, select an available server from the Select 
OVIS Management Station list.

Changing the Time Interval

You can set the time interval to use for display. Sets of service measurements 
(gauges and graphs) are provided for each specific time interval, such as “the 
last four hours” or “the last hour.” The time interval determines which set of 
service measures (gauges or graphs) are visible in the portlet.

To change the time interval, select a value from the Default Time Interval list. 
The specified time interval applies to all service measures within this instance 
of the Internet Services portlet.

Selecting Service Types

You can choose the service type whose gauges and graphs to display in the 
Internet Services portlet.

To add a service type to the portlet instance, select the service type in the 
Available Service Types list, click Add, and then select the check boxes for the 
gauges and graphs to display.

If you override the default OVIS measurement server, the exact OVIS 
customer and password values associated with the current portlet must 
match configuration settings on the specified OVIS measurement server. 
Operations View only gathers data from OVIS measurement servers that 
return the correct customer/password combination.

You can add any number of service types. You can also add the same service 
type to more than one portlet instance and configure different parameters for 
those instances. The more services you choose, the longer the portlets will 
take to display data.
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Selecting Gauges and Graphs for a Service Type

You can choose the gauges and graphs to display for a service type.

• To specify the information to display for a service type, select the check 
box underneath the availability, response time, and/or service level 
objective data to display.

• To delete a service type, select the row for that service type, and then click 
Delete Row.

• To set the display order for the service types, click the arrow buttons to 
arrange the order of the table rows.

To display the multiple gauges from a single service type in a vertical array, 
insert multiple rows for the same service type. Then, clear all but one gauge 
check boxes in each row.
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4 Working with the Internet Services 
Dashboard Portlet

HP OpenView Dashboard Operations View provides the Internet Services 
Dashboard portlet for integrating with HP OpenView Internet Services 
(OVIS).

This chapter describes how to create, configure, use, and customize the 
Internet Services Dashboard portlet. For an overview of the portlet’s 
functionality, see Chapter 1, Introduction to the OVIS Integration.

The portal view development process includes a variety of tools:

1 Use the Operations View Administrator Tool to create the Operations 
View portlets within a portlet application. See Creating the Internet 
Services Dashboard Portlet on page 46.

2 Use the Administrator Tool to perform initial configuration of the 
Operations View portlets. See Configuring the Internet Services 
Dashboard Portlet on page 47.

3 Deploy the portlet application to the portal server. For information, refer 
to the Operations View Administrator Guide.

4 Use the portal server software tools to create a portal view that includes 
the Operations View portlets. For information, refer to the portal server 
software documentation.

5 In a web browser, view the portal view and customize the contained 
portlets. See Using the Internet Services Dashboard Portlet on page 50.

This is the only point at which end users can interact with the Operations 
View portlets. If you allow portlet customization, refer to the Operations 
View Administrator Guide for information about the scope and effects of 
portlet customization.

6 Use the Administrator Tool to maintain the Operations View portlet 
configurations. See Customizing the Internet Services Dashboard Portlet 
on page 54.
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Creating the Internet Services Dashboard Portlet

Use the Administrator Tool to create the Internet Services Dashboard portlet 
within an existing portlet application.

To create the Internet Services Dashboard portlet, follow these steps:

1 In the Administrator Tool, click File→ New→ Portlet.

2 In the Add New Portlet window, enter the following information:

• Portlet Name: The name of the portlet as it appears in the portlet 
application in the scoping pane and in the portal server software tools.

• The portlet name must be unique, start with a letter or underscore 
character, and consist of only alphanumeric and underscore 
characters.

• Portlet Title: The name of the portlet as it appears in the portal server 
software tools and the portal view. Defaults to the portlet name.

• Description (optional): The portlet description as it appears in the 
portal server software tools.

• Portlet Type: Select OVISDashboard from the list.

• Destination Portlet Application: Select the portlet application to 
contain the new portlet.

The new portlet appears in the selected portlet application in the scoping 
pane, and the configuration information for this portlet appears in the 
editor pane.



Working with the Internet Services Dashboard Portlet 47

Version 2.10 HP Operations Dashboard Operations View Integration Guide: OVIS

Configuring the Internet Services Dashboard Portlet

For information on the Internet Services Dashboard portlet configuration 
options, click Help at the bottom of the editor pane to view the online help 
page.

To configure the default settings for the Internet Services Dashboard portlet, 
follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet 
Applications folder, expand the desired portlet application, and then click 
the name of the Internet Services Dashboard portlet (named 
OVISDashboard by default).

The editor pane displays the configuration for this portlet as shown here.
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2 In the General Settings area, make any desired changes.

3 In the OVIS Dashboard Portlet Edit area, set the configuration options. At 
a minimum, specify the correct values for the following options:

• Server

• Customer List

If the customer list is empty, the portlet displays data for all 
customers.

4 Click Save.
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Using the Internet Services Dashboard Portlet

The Internet Services Dashboard portlet presents summarized health 
information for the services configured in OVIS. It also allows you to drill 
down to more detailed data and to see trends, baseline graphs, and alarms. 
The Internet Services Dashboard portlet includes the following views:

• Summary

• Graph

• Trend

• Alarms

Figure 9 shows an example of the Internet Services Dashboard portlet 
summary view.

Figure 9 Deployed Internet Services Dashboard Portlet
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Summary View

The initial view shows the summarized health of all the services configured. 
This information is filtered by the list of customer and consists of three tables. 

The Select Time Frame list at the top sets the time frame of the displayed 
data.

The All Resources table shows the summarized information for all resources 
associated with the configured customer. This information consists of the 
following:

• Health Icon: Color (green, yellow, or red) indicates the overall health of all 
resources.

• SLO Violations (Percent): SLO violations/number of measurements (%).

• Availability (Percent): Number of times all resources were available/
number of measurements (%).

• Alarms (Count): Total number of alarms. You can drill down to the alarms 
view from this link.

• SLO Violations (Count): Total number of SLO violations.

• Samples (Count): Number of probe measurements taken.

• Trend View: A link to drill down to the trend view.

• Graph View: A link to drill down to the graph view.

The Snapshot by Customer table details information for each customer. Each 
row has information about one customer. This information consists of the 
following:

• Customer: Customer name.

• Health Icon: Color (green, yellow, or red) indicates the health of the 
customer.

• SLO Violations (Percent): SLO violations/number of measurements (%).

• Availability (Percent): Number of times the resource was available/
number of measurements (%).

• Alarms (Count): Total number of alarms. You can drill down to the alarms 
view from this link.

• SLO Violations (Count): Total number of SLO violations.
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• Samples (Count): Number of probe measurements taken.

• Trend View: A link to drill down to the trend view.

• Graph View: A link to drill down to the graph view.

The Snapshot by Service Group table details information for each service 
group. This information consists of the following:

• Service Group: Service group name.

• Probe Type: Service target type.

• Health Icon: Color (green, yellow, or red) indicates the health of the 
service.

• SLO Violations (Percent): SLO violations/number of measurements (%).

• Availability (Percent): Number of times the resource was available/
number of measurements (%).

• Response Time (Seconds): Average response time over the number of 
times the resource was available.

• Alarms (Count): Total number of alarms. You can drill down to the alarms 
view from this link.

• SLO Violations (Count): Total number of SLO violations.

• Samples (Count): Number of probe measurements taken.

• Trend View: A link to drill down to the trend view.

• Graph View: A link to drill down to the graph view.

Graph View

The graph view presents graphs for SLO violations, availability, alarms, SLA 
conformance, response time, and other service-related metrics. The 
information presented depends on how the graph view was selected.

• Drilling down from All Resources shows the detail table for all filtered 
customers and the graphs for all customers.

• Drilling down from any customer shows the detail table for all services 
configured for the customer and the graphs for the customer detailed by 
each service.
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• Drilling down from a service shows the detail table for all targets 
associated with that service and the graphs for the service detailed by 
each target. Further drilling down from a target shows the detail table for 
each location and the graphs for the target.

The Select Time Frame list at the top sets the time frame of the displayed 
data.

Trend View

The trend view shows the baseline data for the item being drilled down. You 
can select various metrics from the Metric list. By default the data shown is 
for all days of the week. This can be changed to display baseline for a single 
weekday using the Day list.

Alarms View

The alarms view displays a table of all alarms associated with the item being 
drilled down. The table includes the following columns:

• Severity: Alarm severity.

• Time: Date and time stamp.

• Customer: Customer name associated with the target that generated the 
alarm.

• Service Group: Service group name associated with the target that 
generated the alarm.

• Target: Target generating the alarm.

• Message Text: Text of the alarm message.

• Probe Name: Service target type.

• Probe system: System where the probe is executed.
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Customizing the Internet Services Dashboard Portlet

If you grant portlet edit privileges, a user of the Internet Services Dashboard 
portlet can change the following configurations for their portlet instance:

• OVIS management station

• Data time frame

Figure 10 shows an example of the Internet Services Dashboard portlet edit 
page.

Figure 10 Internet Services Dashboard Portlet Edit Page

Changing the OVIS Management Station

By default, Operations View contacts the OVIS measurement server specified 
in the current portlet properties (see On the Operations View Server on 
page 28). Operations View gathers OVIS data from the selected server.

To override the default OVIS server, select an available server from the Select 
OVIS Management Station list.

If you override the default OVIS measurement server, the exact OVIS 
customer and password values associated with the current portlet must 
match configuration settings on the specified OVIS measurement server. 
Operations View only gathers data from OVIS measurement servers that 
return the correct customer/password combination.
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Changing the Time Frame

You can set the time frame to use for display. Sets of service measurements 
(gauges and graphs) are provided for each specific time interval, such as “the 
last four hours” or “the last hour.” The time frame determines which set of 
service measures (gauges or graphs) are visible in the portlet.

To change the time frame, select a value from the Select Time Frame list. The 
specified time frame applies to all service measures within this instance of the 
Internet Services Dashboard portlet.
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5 Filtering OVIS Data

HP OpenView Dashboard Operations View allows you to associate resources 
with customers so that data is automatically filtered appropriately when a 
user displays an Operations View portlet for HP OpenView Internet Services 
(OVIS).

The Internet Services portlets depend upon portlet initialization parameters 
to accomplish this. See Working with the Internet Services Portlet on page 33 
and Working with the Internet Services Dashboard Portlet on page 45.

Filtering for the Internet Services portlets is accomplished through the 
customer configuration on the OVIS measurement server.



58 Chapter 5

HP Operations Dashboard Operations View Integration Guide: OVIS Version 2.10



59

Index

A
adding

services to a portlet, 43, 55

C
change time interval, 39

charts, 41

communication path
HP OpenView Internet Services to 

Operations View, 19

configuring
Internet Services Dashboard portlet, 54
Internet Services portlet, 42
OVIS for non-English language, 30

customers, 40

D
default

time interval, 43, 55

documentation
HP Operations Dashboard, 9

G
gauges

displaying vertically, 44
icons, 39

graphs, 41

H
HP OpenView Internet Services

and Operations View, 15, 17, 18
Operations View portlet, 17
service types, 15

HP OpenView Internet Services Dashboard
Operations View portlet, 18

HP Operations Dashboard
documentation, 9

http/https
configuration, 28

I
Internet Services Dashboard portlet, 15

adding and removing services, 55
change default time interval, 55
configuring, 54
understanding, 15, 50

Internet Services portlet
adding and removing services, 43
adding services, 43
change default time interval, 43
change time interval, 39
charts, 41
configuring, 42
gauges, 39
graphs, 41
service types, 15, 39
understanding, 15, 38



60

N
non-English language mode, 30

configuring OVIS, 30

O
Operations View

and HP OpenView Internet Services, 15, 
17, 18

non-English language mode, 30
server configuration, 28

R
removing services, 43, 55

S
server configuration

Operations View, 28

service groups, 39

service types, 15
gauge icons, 39
graphs, 41
information presented, 39

U
understanding

internet services, 38
internet services dashboard, 50

W
work shifts, 40



 



 


	Operations View Integration Guide: HP OpenView Internet Services
	Contents
	Documentation Roadmap
	HP Operations Dashboard Manuals
	Operations View Online Help
	Documentation Updates
	Documentation Conventions

	1 Introduction to the OVIS Integration
	The Internet Services Portlet for Operations View
	The Internet Services Dashboard Portlet for Operations View
	Interaction Between OVIS and Operations View

	2 Configuring the Operations View Connection to OVIS
	On the OVIS Measurement Server
	Configuring MSDE to Run in Mixed Mode
	Configuring SQL Server to Run in Mixed Mode
	Determining the MSDE Port Number
	Determining the SQL Server Port Number
	Configuring an Instance of MSDE to Use a Static Port
	Configuring an Instance of SQL Server to Use a Static Port

	On the Operations View Server
	Running in Languages Other Than English
	Configuring Operations View to Access UTF-8 Data From OVIS

	HTTPS Support

	3 Working with the Internet Services Portlet
	Creating the Internet Services Portlet
	Configuring the Internet Services Portlet
	Using the Internet Services Portlet
	Internet Services Gauges
	Internet Services Graphs

	Customizing the Internet Services Portlet
	Changing the OVIS Management Station
	Changing the Time Interval
	Selecting Service Types
	Selecting Gauges and Graphs for a Service Type


	4 Working with the Internet Services Dashboard Portlet
	Creating the Internet Services Dashboard Portlet
	Configuring the Internet Services Dashboard Portlet
	Using the Internet Services Dashboard Portlet
	Summary View
	Graph View
	Trend View
	Alarms View

	Customizing the Internet Services Dashboard Portlet
	Changing the OVIS Management Station
	Changing the Time Frame


	5 Filtering OVIS Data
	Index



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (Adobe RGB \0501998\051)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.6
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize false
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile (None)
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /JPXEncode
  /AutoFilterColorImages false
  /ColorImageAutoFilterStrategy /JPEG2000
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 100
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /JPXEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG2000
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 100
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck true
  /PDFX3Check false
  /PDFXCompliantPDFOnly true
  /PDFXNoTrimBoxError false
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier (CGATS TR 001)
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /Description <<
    /CHS <>
    /CHT <>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA (Utilizzare queste impostazioni per creare documenti Adobe PDF che devono essere conformi o verificati in base a PDF/X-1a:2001, uno standard ISO per lo scambio di contenuto grafico. Per ulteriori informazioni sulla creazione di documenti PDF compatibili con PDF/X-1a, consultare la Guida dell'utente di Acrobat. I documenti PDF creati possono essere aperti con Acrobat e Adobe Reader 4.0 e versioni successive.)
    /JPN <>
    /KOR <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die moeten worden gecontroleerd of moeten voldoen aan PDF/X-1a:2001, een ISO-standaard voor het uitwisselen van grafische gegevens. Raadpleeg de gebruikershandleiding van Acrobat voor meer informatie over het maken van PDF-documenten die compatibel zijn met PDF/X-1a. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 4.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings when submitting to HP. These settings require font embedding.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /HighResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


